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I. Introduction 

Congratulations on your purchase of the SoundTrack Audio DSP24. The Audio DSP24 is a PCI 
digital interface soundcard designed to work as a stand-alone interface or with a variety of 
breakout boxes available from Hoontech. 

There are two hardware versions. The normal SoundTrack Audio DSP24 is usually used together 
with external boxes to provide multiple in- and output channels. The SoundTrack Audio DSP24 
MK II has additionally 2 analog in- and 2 anlog output channels with high-quality 24bit/96kHz 
AD- and DA-converters. Most informations in this manual are valid for both hardware revisions. 

You should have received the following with your Audio DSP24: 

• Hoontech SoundTrack Audio DSP24 or Audio DSP24 MK II soundcard 

• Digital XG DB I I/O card 

• 4x4 pin S/PDIF I/O cable 

• 2x2 pin CD-ROM digital cable 

• 4x3 pin CD-ROM analog cable 

• 10 pin flat digital audio cable 

• 4 XLR to 15pin cable for balanced analog I/O (only DSP24 MK II) 

• 10-pin flat ribbon cable for connection with SoundTrack Digital Audio (optional) 

• AES/EBU adapter cables – 2 XLR to 1/8" jack adapters (optional) 

• driver and installation CD 

• this manual 
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Superb multi-track quality: 

The Audio DSP24 supports up to 24-bit resolution and 96kHz sample rates and includes a digital 
daughter card (XG DB I) that employs the AES/EBU, optical and coaxial S/PDIF standards. The 
Audio DSP24 can handle up to ten I/Os when the card is combined with the daughter card – all at 
up to 24-bit and 96kHz. In addition, all internal signal paths are processed at 36-bit resolution 
ensuring the highest amount of headroom and fidelity. 

Expandability: 

The user can install up to four Audio DSP24 soundcards in one system. The user can set one card 
as the master clock controller via software or slave all cards to an external S/PDIF clock source. 
No jumpers are required. 

In addition, the Audio DSP24 can be used with one or more Hoontech external boxes and 
rack-mountable breakout boxes (using the H-BUS interface) such as: 

ADC III – 24bit/96kHz, 8 analog ¼" balanced inputs, Line In and Mic in preamplifiers with 48V 
“phantom power” for condenser microphones. 

DAC III – 24bit/96kHz, 8 analog ¼" balanced outputs, AES/EBU, optical and coaxial S/PDIF 
connections are also provided. 

Digital Modulator III – 24bit/96kHz, S/PDIF and AES/EBU I/O connections connections are 
supported. Inputs are automatically synchronized. 

ADC&DAC2000 – 24bit/96kHz, 8 unbalanced ¼" I/O, 2 XLR inputs with gain control, headphone 
output with gain control and MIDI I/O. 

Digital Station 2000 – 8 channel ADAT and TDIF I/O interface. 

It is possible to connect several external boxes to one card at the same time. So you can build up a 
system with exactly the number of inputs and outputs you need now and you can expand it later. 

Intuitive Software Interface: 

The Audio DSP24 comes with a suite of software interfaces. 

The External Links software is the Audio DSP24 routing center and allows you to route/patch 
signal path for a variety of devices on a virtual patch bay. 

The External Mixer (20 channels) sets input/output and panning levels for the Wave 1/2, Wave 
3/4, Wave 5/6 and Wave 7/8 channels, (stereo pairs each), S/PDIF In and Out, during recording 
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and mixdown. The output of the External Mixer can be played through the outputs of external 
boxes or through the digital output of XG DB I. 

The Internal Mixer allows settings for input and output levels for Wave, Line In, MIC, CD In and 
Auxiliary devices. The output signal of the Internal Mixer is always played through the Line 
Output on the card. This makes it possible to use the card as an ordinary standard soundcard. 
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II. Specifications 

• PCI 2.1 compliant interface 

• 10 input and 10 output channels using XG DB I and external boxes (External Mixer using the 
H-BUS interface) 

• Sample rates in kHz: 32, 44.1, 48, 88.2, and 96 

• supported converter resolution: 16-bit, 20-bit and 24-bit 

• MPU-401 MIDI interface 

• Internal CD in, Line In, Mic In, Line Out via AC-97 Codec / Internal Mixer (there is no Mic- 
and Line In on DSP24 MK II) 

• AES/EBU, optical and coaxial S/PDIF standards support 

• compatible with SoundTrack Digital Audio 

• Drivers for Windows 95/98/ME, NT4 and Windows 2000 available 

• Support for ASIO 2.0 

• GSIF-support 
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III. In- and output connectors 

SoundTrack Audio DSP24 

 

1. Mic In – 1/8" jack 

2. Line In – 1/8" stereo jack 

3. Line Out – 1/8" stereo jack 

4. H-BUS Digital I/O connection via 44x44 pin cable for external boxes 

5. 16 pin connector for optional Digital I/O card or analog bracket 

6. MIDI connector (cable optional) 

7. Digital Audio connector – used when a SoundTrack Digital Audio card is installed 

8. CD In – can be connected to the analog output from CD-ROM 

9. Aux – can be connecte to the analog output from a TV-card or other analog source 

10. S/PDIF I/O – Connection to the XG DB I daughtercard 

11. CD In – digital output from CD-ROM (disabled when S/PDIF active and vice-versa) 
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SoundTrack Audio DSP24 MK II 

 

1. 15pin D-SUB connector for 4 XLR to 15pin cable 

2. H-BUS Digital I/O connection via 44x44 pin cable for external boxes 

3. Jumper settings for 1/8"-Output 

4. Bracket connector – used when a SoundTrack DAC or Analog Bracket is installed 

5. CD In – can be connected to the analog output from CD-ROM 

6. Aux – can be connecte to the analog output from a TV-card or other analog source 

7. CD In – digital output from CD-ROM (disabled when S/PDIF active and vice-versa) 

8. S/PDIF I/O – Connection to the XG DB I daughtercard 
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IV. Block diagram 

 

Note: The Internal and External Mixer are completely independent. The Internal Mixer controls 
normal PC audio functions such as Windows sounds or CD Audio playback. It is represented by 
the AC-97 Codec on the card. The External Mixer section is separately used by the audio 
recording/mixing applications with support for up to 24bit/96kHz. 

The Mic In, Line-In, Line-Out, Aux and CD-In are routed through the AC-97 Codec on the 
AudioDSP24 and are controlled by the Internal Mixer. 

S/PDIF I/O are connected to the XG DB I digital I/O board via the External Links function. 
S/PDIF Master Clock rates are set in the Hardware Settings and can be synchronized via an 
external S/PDIF source or internally on the Audio DSP 24. The default setting is 44.1kHz. 

Up to 4 external ADC and DAC boxes can be routed through the Audio DSP24. The input and 
outputs of these external boxes are connected to the External Mixer. 
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V. Hardware installation 

Make sure the computer is switched off and unplugged. Remove the external computer cover. 
Check that you have connected the Audio DSP 24 and the XG DB I correctly as described above. 
Insert the Audio DSP 24 PCI card into a free PCI slot making sure that it is pressed firmly into 
position and secure it to the computer case. Position the XG DB I along side and secure it to the 
computer case. 

The Audio DSP 24 card system consists of the main PCI card (Audio DSP24) and a secondary 
daughter board (XG DB I). Hook the included gray lead wire to the CNN2 connection socket on 
the Audio DSP24 and then into the daughter card to connect the cards. 

 

You can use either the analog or digital outputs from the CD ROM drive. The CD digital output 
can be connected to either the CNN3 on the Audio DSP24 or the socket marked J3 on the XG DB 
I. The CD analog output can be connected to CON1 on the Audio DSP24. All required leads are 
included in the packaging. Please check with your CD ROM manufacture to ensure that it supports 
digital output. 

If you own the Audio DSP24 MK II, please connect the 4 XLR to 15pin D-SUB cable to the 15pin 
connector on the backside of the card. 

External hardware connection 

External converters are connected to the Audio DSP24 host card by using the thick cream colored 
44-pin cable included with your system. All external converters and optional boxes can be daisy 
chained using the DATA In and DATA Out 44-pin connections (H-BUS). 

To connect the first external box (like the ADC&DAC2000) please follow these directions: 
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Connect the long cream 44-pin lead from the 44-pin connector on the rear of the Audio DSP24 to 
the DATA Out of the external converter. 

 

Caution: never connect or disconnect the 44pin cable when the computer is turned on. Always 
shot down your system before. 

DIP Switch settings - you need to have one DIP switch in the UP position. There are 10 DIP 
switches on the side of the each external box (except DAC III). The down position represents OFF 
for all switches. The up position represents ON for all switches. Switches 1-4 set the units unique 
specific ID for software control. This is necessary so the system can differentiate individual ADC 
converters or external boxes, when several units are connected to one card. At least one DIP 
switch must be in the up position. 

Up to four external devices can be used at the same time with the Audio DSP 24. An example 
would be a system with the ADC&DAC2000 (8 channel analog I/O) and the Digital Station 2000 
(ADAT and TDIF I/O). 

Remember, each box needs a unique ID number. If you connect a second box, the Box ID number 
controlled by the DIP switch on the right side must be different. After setting the correct DIP 
switch, connect the second box using the supplied cream 44-pin cable to DATA In of the first 
external box and the DATA Out of the second one. 

Chapter X. contains more details about the different external boxes and other expansion options 
for the SoundTrack Audio DSP24. 
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After everything is connected to the card, you can re-assemble your PC and continue with the 
driver and software installation. 
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VI. Driver and software installation 

Driver installation 

The Audio DSP24 comes with a CD that contains drivers for Windows 95/98/ME and NT4. The 
following instructions pertain to Windows 98 only. The installation under Windows 95 or 
Windows ME is very similar. 

After installation of the Audio DPS24 in a PCI slot in the computer, boot up the system. Windows 
98 will detect new hardware and display the following screen. 

 

Click Next. 



SOUNDTRACK Audio DSP24 

- 14 - 

 

Select Search for the best driver for your device and click Next. 

 

Check Specify a location. Type in the <drivename>:\sound\dsp24\driver in the window displayed 
above and click Next. In the alternative, you can click Browse and find the above file on the CD, 
then click Next. 
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After Windows finds the driver you should see the above screen naming the driver file indicated in 
the screenshot. Click Next. 

 

At this window complete the installation by clicking Finish. Windows will now install the driver 
for you through a series of installation screens. If you are prompted to do anything (this would be 
unusual), it is usually safe to simply press Enter.  
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After the driver is installed ensure the installation worked by pressing Start>Settings>Control 
Panel>System>Device Manager>Sound, video and game controllers. You should see the 
SoundTrack device listed there. Highlight it and click on Properties. You should see the message 
This device is working properly. Click on the Resources tab, you should see the message No 
conflicts. If so, congratulations are in order. You have successfully installed the drivers for the 
Audio DSP24. 

 

Software installation 

After successfully installing the driver above, setup your Audio DSP24 software. Insert the 
installation CD into the drive. Click Start>Run and type in <drive letter>:\sound\dsp24\setup.exe 
in the window. Click OK. 
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You will see the SoundTrack setup logo and see the Windows Setup indicator begin to work as 
below. 

 

Next you will see the Welcome to SoundTrack Setup window: 

 

Click Next. 
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Choose the default directory by clicking Next or select your own by clicking Browse then Next. 

 

Choose the default Program folder name by clicking Next or type in your own and click Next. Now 
you will next see the SoundTrack Audio DSP24 installation indicators. 
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Just wait while the files are copied to your system. Next you will see the setup completion window 
and will be asked if you wish to launch External Links: 

 

Click Finish if you wish to Finish and launch External Links. Declick the Launch the External 
Links button if you do not wish to do so and click Finish. Congratulations! You have successfully 
installed the SoundTrack Audio DSP24 software. 



SOUNDTRACK Audio DSP24 

- 20 - 

VII.External Links 

The External Links application is the command center for the Audio DSP24 system. A small blue 
icon was added to the Systray during installation. Right-clicking the mouse on the icon will open 
the menu below. 

  

 

Clicking on Open External Links will launch External Links. 

 

With External Links signals can be routed in a wide variety of ways. You can define the inputs for 
recording and the setup you need for monitoring. Also the routing for the outputs is made with 
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External Links. The program always displays the current signal routing on the screen. The inputs 
are on the right section, the outputs are left. Here is a description about the specific sections inside 
the program: 

1. External Mixer: Loads the External Mixer which can be used to control all input and 
output channels. You can use the External Mixer for monitoring during recording and 
playback of several channels. 

2. Card No.: If multiple Audio DSP24s are being used, the active card is highlighted here. 
To change the active card, click on the corresponding card number. 

3. Clock: Displays if the card itself controls the synchronisation (Internal Master Clock) or 
an external device connected to the digital inout (External Master Clock). 

4. DAC (digital to analog converter – represents the outputs): 

• Output 1/2 (Front), output to front speakers (when using a digital amplifier) or Out 
1/2 (stereo) of the DAC box. 

• Output 3/4 (Rear), output to rear speakers (when using a digital amplifier) or Out 
3/4 (stereo) of the DAC box. 

• Output 5/6, output to Out5/6 (stereo) of the DAC box. 
• Output 7/8, output to Out7/8 (stereo) of the DAC box. 

5. S/PDIF In: S/PDIF signal from the XG DB I or CD digital output connects here. You can 
record this signal using the device ADSP24 S/PDIF In (n). 

6. Wave S/PDIF Out: Digital out from XG DB I output connects here. If you want to play 
audio data through this output, you need to use the device ADSP24 S/PDIF Out (n). 

7. Input 1/2 to 7/8: Digital signal from external boxes such as the ADC & DAC 2000 or 
Digital Modulator III per input number. You can record these signals using ADSP24 Ext. 
(n) Input1/2, etc. 

8. WaveOut 1/2 to 7/8: Use output devices such as ADSP24 Ext. (n) or WaveOut1/2, etc. 
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VIII. Mixer controls 

Internal Mixer 

Clicking on Call Internal Mixer will launch the Internal Mixer. 

 

The user can control the systems internal components with the Internal Mixer. The Internal Mixer 
works basically like a normal soundcard and can be used for standard multimedia software or 
games for example. Please see the following section with more details: 

Master 

Controls the output volume of the Internal Mixer. The signal controlled here will be played 
through the Line Out connector of the PCI card itself. 

 

You can control the panning and the master volume. Muting the signal is possible as well. 
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Wave 

Controls the volume of the signal played using the device ADSP24 Int. WaveOut (n). 

 

You can control the panning and the wave volume. Muting the channel is possible as well. 

Record 

If you want to record a signal from the Internal Mixer (using the device ADSP24 Int. Input (n)), 
you can control the signal volume and the source in this section. 

 

With the drop-down menu you can select the record source. The slider controls the volume of your 
recording. 

Microphone 

Controls the volume of the microphone input on the PCI card itself. Please note that the DSP24 
MK II does not have this microphone input. 
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You can control the volume and also boost the input level by 20dB. 

Line In 

This sections is used to control the volume of the Line Input signal (on the PCI card itself). Please 
note that the DSP24 MK II does not have this Line In connector. 

 

You can control the panning and the Line In volume. Muting the channel is possible as well. 

CD In 

This sections controls the volume of the internal analog CD input of the PCI card. 
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You can control the panning and the CD volume. Muting the channel is possible as well. 

Aux 

This sections controls the volume of the internal analog Aux input of the PCI card. 

 

You can control the panning and the Aux volume. Muting the channel is possible as well. 

 

If you are using more than one card you must select the card you wish to control from the 
pull-down menu of the mixer. 
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External Mixer 

With the External Mixer you can control all incoming and outgoing signals (20 channels in total). 
Open it by clicking on Call External Mixer. 

 

Note: The External Mixer will only change the audible signal. You can output it either through 
Ouput 1,2 and/or through the S/PDIF Output (setup in External Links). When you are recording an 
input signal, the External Mixer does not change the signal level. This ensures that you are always 
recording with best possible quality. 

Master 

Controls the output volume of the External Mixer. The signal controlled here will be played 
through Output 1,2 and/or the S/PDIF Output. 

 

You can control the the volume of the left and right channels independandly. Muting the signal is 
possible as well. 
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Wave (1/2 to 7/8) 

In the Wave section you can control the volume of the playback signal (for the devices ADSP24 
Ext.(n) WaveOut x/x). 

 

Muting each channel is possible. Also you can control the panning independand for the left and 
right channel of each stereo device. 

S/PDIF Out 

In the S/PDIF Out section you can control the volume of the signal of the device ADSP24 Ext. 
S/PDIF Out (n). 

 

Muting the left and right channel is possible independandly. 

S/PDIF In 

This section controls the signal from the digital input of the card. 
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Muting the left and right channel is possible independandly. 

Input (1/2 to 7/8) 

These sections are controlling the volume of the different input channels. 

 

Muting the left and right channel is possible independandly. 
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IX. Hardware settings 

Clicking on Hardware settings will open the Hardware settings window. You can select the 
Internal Master Clock settings in kHz (22, 32, 44.1, 48, 88.2 and 96kHz) for synchronisation, 
DMA buffer settings for Wave and ASIO devices and External Master Clock settings here. 

 

Audio Data Handling 

This function enables the system to allow or block continuing operation when a specific converter 
resolution is exceeded (usually 24-bit). 

Clock and Sample Rates 

These settings determine the sample rate at which the system will operate and whether ab External 
Master Clock will control clock timing. The Audio DSP24 can be synchronized to an external 
device or set its own internal rate and impose this rate on the other devices (conncted to the digital 
output). You must ensure that all components are operating at the same sample rate. Checking the 
Rate Locked box will result in support for only the indicated sample rate. With Reset Rate After 
Play it is possible to change the samplerate back to the previous setting after an application 
stopped playback. 

Caution: Please note that you cannot use the card when no signal is connected to the S/PDIF input 
when the option External Master Clock is activated at the same time. The card cannot record or 
playback without a significant loss in audio quality in that case. So please make sure that the 
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option Internal Master Clock is activated before you start to record. However, to record from a 
S/PDIF source through XG DB I, the option must be set to External Master Clock. 

DMA Buffer Transfer Latency 

These settings determine latency response to system change commands. Higher buffer settings 
will result in greater latency but fewer playback and recording dropouts. Lower buffer settings 
will result in lesser latency but you may encounter playback and recording dropout problems as 
the system gets overloaded. Many software programs provide suggested buffer settings that you 
can try. Each system is different and may require experimentation and adjustment to find optimal 
buffer setting levels. 

When you experience drop outs during playback and/or recording, please try to increase these 
values. 
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X. Connection with input devices and external boxes 

The Audio DSP24 can be connected with a variety of external and internal devices such as the 
Hoontech rack-mountable box series (H-BUS), the XG DB I digital I/O board and the Digital 
Audio card. Simultaneous connection of several items via the External Links function is possible. 

XG DB I 

The XG DB I board features CD digital input, Optical I/O, Coaxial I/O and AES/EBU 
connectivity with the Audio DSP24. 

 

1+2. AES/EBU connectors. To use them, you will need an 1/8" to XLR adapter cable. 
3+5. Optical In/Out connectors. 
4+6. Coaxial In/Out connectors. 
7. 4-pin connector for use with provided cable to hook up to a Digital soundcard. 
8. CD digital In 2-pin connector for digital out CD-ROM signals. 
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Connection 

 

External Links setup 

 

You can make this connection via the option Inputs>Add Inputs>XG DB I. You need to do this in 
order to us the digital input of the card. 

Note: If you wish to make a virtual connection from XG DB I to S/PDIF In, you must have an 
active device connected to the coaxial, optical or AES/EBU input such as a DAT-recorder. This 
connection changes the Internal Master Clock option to External Master Clock automatically (see 
IX. HARDWARE SETTINGS). 

MK II Analog I/O cable 

The 4 XLR to 15pin D-SUB cable is included with the DSP24 MK II version. You should have it 
connected to the 15pin connector on the DSP24 MK II PCI-card. 
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1+3. balanced outputs (Channel 1,2) 
2+4. balanced inputs (Channel 1,2) 
5. 1/8" output for Internal Mixer 

External Links setup 

 

You can make this connection via the option Inputs>Add Inputs>MK II Input. You need to do this 
in order to us the two input channels. 

This cable cannot be connected with the normal hardware version of the SoundTrack Audio 
DSP24. 
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SoundTrack Digital Audio 

The SoundTrack Digital Audio 4ch and 16ch cards from Hoontech provide DSP based sampling 
and mixing functions. If you use such a soundcard, you can cascade it internally with the Audio 
DSP24. 

Connection 

 

Align red-line on flat cable with triangle marking on the board for proper connection. Now the 
output signal of the SoundTrack Digital Audio card is available in the External Mixer of your 
SoundTrack Audio DSP24. 

External Links setup 

 

You can make this connection via the option Inputs>Add Inputs>Digital Audio. 
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External Boxes 

Up to four external boxes with input channels can be connected to the Audio DSP24. 

Connection 

 

If you connect several external boxes to the same Audio DSP24 card, the first card is connected to 
the card as shown in the picture above. The second box is connected to the second data connector 
of the first box and so on. You have to make sure that each box has a unique number. The number 
of an external box can be set with the DIP switches on the right side. Make sure to select the 
number before you are mount the box to a rack. 

External Links setup 
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If you use a ADC III or ADC&DAC2000 box for example, please select the corresponding entry 
in External Links (e.g. Inputs>Add Inputs>ADC&DAC2000). If you use a different external box, 
you can choose General Box. Be sure to set the same box ID number in the software as the DIP 
switch setting on the right side of the external box. 
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XI. Usage with software applications 

For each application you are using with the Audio DSP24 you have to follow some configuration 
steps. Basically, every stereo input or output channel of the card can be used like a normal 
soundcard using the corresponding devices. Normally every program will have a configuration 
function where you can select the devices. 

Available in- and output devices 

The available wave devices for playback and recording are (“n” will be substituted with the 
number of the installed Audio DSP24 card, normally 1): 

• ADSP24 Int. WaveOut (n) – plays audio data through the Internal Mixer (which will be 
audible on the Line Out of the card). Please note that this driver only supports 16bit/48kHz as 
maximum resolution and samplerate. 

• ADSP24 Ext.(n) WaveOut 1/2 – first stereo wave output device. Use this driver to play audio 
through outputs of an external box. See section VII in this manual for details. 

• ADSP24 Ext.(n) WaveOut 3/4 – second stereo wave output device. Use this driver to play 
audio through outputs of an external box. See section VII in this manual for details. 

• ADSP24 Ext.(n) WaveOut 5/6 – third stereo wave output device. Use this driver to play audio 
through outputs of an external box. See section VII in this manual for details. 

• ADSP24 Ext.(n) WaveOut 7/8 – fourth stereo wave output device. Use this driver to play 
audio through outputs of an external box. See section VII in this manual for details. 

• ADSP24 Ext. S/PDIF Out (n) – plays audio through the stereo S/PDIF digital output of XG 
DB I. See section VII in this manual for output routing details. 

• ADSP24 Multiple PCM Out (n) – this is an interleaved driver for playback of several channels 
at the same time. Some older audio applications are using this driver to access multiple 
channels on soundcards. 

• ADSP24 Int. Record (n) – records the signal from Internal Mixer. Use this driver to record 
from the Line Input on the card. Please note that this driver only supports 16bit/48kHz as 
maximum resolution and samplerate. 

• ADSP24 Ext.(n) Input 1/2 – first stereo input driver to record input signals from external 
boxes. Check section X in this manual to learn how to use external boxes. 

• ADSP24 Ext.(n) Input 3/4 – second stereo input driver to record input signals from external 
boxes. Check section X in this manual to learn how to use external boxes. 
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• ADSP24 Ext.(n) Input 5/6 – third stereo input driver to record input signals from external 
boxes. Check section X in this manual to learn how to use external boxes. 

• ADSP24 Ext.(n) Input 7/8 – fourth stereo input driver to record input signals from external 
boxes. Check section X in this manual to learn how to use external boxes. 

• ADSP24 S/PDIF In (n) – records signal from the S/PDIF input of XG DB I. Check section X 
in this manual to learn how to use XG DB I. 

• ADSP24 Multiple PCM In (n) – this is an interleaved driver to record several channels at the 
same time. Some older audio applications will use this driver to access multiple channels on 
soundcards. 

• ADSP24 Digital Mixer (n) – with this driver you can record the output signal of the External 
Mixer. 

Additionally, the card provides an ASIO 2.0 driver called ADSP24 ASIO. It allows access to all 10 
input and 10 output channels of the External Mixer in applications that support ASIO (like Cubase 
VST). ASIO allows applications to record and playback at a very low latency (down to 3ms). This 
means that it is possible to apply realtime effects with your systems CPU input or output signals. 
Also, you can use software synthesizers to output through ASIO. 

Please note that most applications will need special settings to ensure that the SoundTrack Audio 
DSP24 is working properly. We are continuously testing the card with various popular 
applications. In the following sections we have provided examples of a few applications. Please 
take the time to review it to avoid problems later. If you still encounter problems or if you are 
using different programs, we recommend to contact Hoontech using the Q&A support forum on 
the internet (http://www.hoontech.com). 
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Setting up Emagic Logic SoundTrack24 

Logic SoundTrack24 is a special version of the Logic Software from Emagic, designed to be used 
with the Audio DSP24 card. It can either use the ASIO or the MME driver of the Audio DSP24 for 
recording and playback. 

• call File>Hardware settings in External Links. 

 

• select the ASIO buffer size: we recommend using a value of about 1800 – depending on the 
system performance. 

• make sure the option Rate Locked is disabled 

• set the option MultiTrack Wave Drivers to Independent 

• launch Logic SoundTrack24 and select the option Audio>Audio Hardware & Drivers. 

  

• select Audio & Hardware Drivers and select ASIO ADSP 24 as ASIO device if you want to 
use the ASIO driver. If you want to work with 24-bit resolution, enable the option 20/24 Bit 
Recording. 
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• If you prefer to use the MME driver, select one of these entries: 

MME ADSP24 10ch/24bit – record and playback on all channels with 24-bit resolution 
MME ADSP24 10ch/16bit – record and playback on all channels with 16-bit resolution 
MME ADSP24 Digital/24bit – to use just the digital in- and outputs with 24-bit resolution 
MME ADSP24 Digital/16bit – to use just the digital in- and outputs with 24-bit resolution 

• exit Logic and launch it again to activate the settings. 

Please also refer to the documentation of Logic SoundTrack24. 
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Setting up Steinberg Cubase VST/24 3.72 

Cubase VST 3.72 from Steinberg uses the ASIO specification to access recording hardware. 
Steinberg has defined ASIO and improved support for recording multiple channels at the same 
time. ASIO features reduced latency for playback of VST plugins and instruments. Please note, 
that other Steinberg programs (like Nuendo, Cubasis VST or Cubase VST 5.0) have a very similar 
setup when using the ASIO driver. To setup the Audio DSP24 in Cubase VST, please follow these 
steps: 

• call File>Hardware settings in External Links. 

 

• Select the ASIO buffer size. On faster systems (Pentium III, Athlon) it is usually safe to use 
the smallest setting. This will give you 3ms of latency (at 96kHz, its 7ms for 48kHz and 8ms 
for 44.1kHz). On other systems you may try this setting but increase the buffer size later, 
depending on the performance. 

• Start Cubase VST and select the option Audio>System. 
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• In the section Audio Performance, set Number of Channels to 16 (recommended). 

• In the Monitoring section, select Global Disable (recommended). If you want to monitor 
signals in realtime and adding VST plugin effects at the same time, select Tape Type instead. 

• In the upper right corner under ASIO Device select ADSP24 ASIO. By clicking on ASIO 
Control Panel, you can also change the samples per buffer value. 

• Below that you can choose the Sample Rate. 

• If you want to use the Audio DSP24’s realtime monitoring functions (without adding effects 
to the monitor signal), select ASIO Direct Monitoring 
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To define which input and outputs to use in Cubase VST, first go to Audio>Inputs. A window will 
appear that allows you to activate or deactivate each input (stereo). You can assign these inputs to 
the channels in the VST Channel Mixer then (via Audio>Monitors). For the outputs, you need to 
open Audio>Master. In this window you can deactivate a stereo bus for each stereo output. These 
busses can be used internally in Cubase VST to route signals to the outputs. You can find more 
information about this in the Cubase VST documentation. Also, the latest updates for Cubase VST 
can be downloaded from http://www.steinberg.de. 
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Setting up Emagic Logic Audio Platinum 4.5 

The powerful Audio-/MIDI-Sequencer Logic Audio Platinum 4.5 (and higher) from Emagic also 
uses ASIO drivers. Follow these steps to setup the application for the Audio DSP24. 

• call File>Hardware settings in External Links. 

 

• select the ASIO buffer size: we recommend using a value of 800 or higher – depending on the 
system performance. 

• launch Logic Audio Platinum and select the option Audio>Audio Hardware & 
Drivers>Audio Driver 2. 
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• check the box ASIO and select ASIO ADSP24 as ASIO device. If you want to record with 
24-bit resolution, check the box 20/24 Bit Recording 

• exit Logic Audio and launch it again to activate the changes. 

You can get the latest informations about Logic Audio Platinum at http://www.emagic.de. If you 
use previous 4.xx versions of Logic Audio, we recommend to get the free update to Version 4.5 at 
least. 



SOUNDTRACK Audio DSP24 

- 46 - 

Setting up Cakewalk 9.x 

Cakewalk is a famous Audio-/MIDI-Sequencer and Recordingsoftware. It uses the MME drivers 
of the SoundTrack Audio DSP24. 

• launch Cakewalk and select Options>Audio. The DirectShow Audio dialog will be displayed. 

  

• Click on Drivers. You will see a list of MME devices for Input and Output. Select the entries 
you want to use (check the section AVAILABLE IN- AND OUTPUT DEVICES earlier in this chapter 
for reference). 
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• Go back to General and select Wave Profiler. Follow the directions on screen until you see 
the message Audio hardware has been successfully profiled. 

• Select ADSP24 Ext.(n) WaveOut 1,2 as Playback Timing Master and ADSP24 Ext, (n) Input 
1,2 as Record Timing Master. If you are recording from the S/PDIF input, select ADSP24 
S/PDIF In (n) instead. The option Audio Driver Bit Depth should be set to 24. 

• Select the sample rate and resolution you want to use under Default Settings for New Projects. 

• Mixing Latency: Basically, you can set Buffers in Playback Queue as 4. Settings less than 4 
will result in lower latency but the system performance could be lower, resulting in possible 
drop-outs. Start with buffer sizes suggested by the Effective latency tests, usually around 
100msec. When the latency needs to be under 100msec, click on the Advanced tab and enable 
the WavePipe(TM) Acceleration option. Please note that each system will have different 
optimal settings. You should experiement with the settings to get the perfect setup for your 
system. 

• Under Device Profiles, enable the option Use Wave Out Position For Timing. 

You can get the latest updates and informations on Cakewalk on http://www.cakewalk.com. 
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Setting up BPM Studio Professional from Alcatech 

BPM Studio is a professional DJ mixing application with support for CD, Wave audio and MP3 
files. Use the ASIO drivers of the Audio DSP24 to achieve low latency and excellent performance. 
Follow these steps to setup the application for the Audio DSP 24. 

• Call File>Hardware settings in External Links. 

 

• Select the ASIO buffer size: we recommend to use the value 1800 or lower, depending on the 
system performance. 

• Launch BPM Studio and open the Audio I/O dialog (using the popup menu opened with a 
click on the right mouse button). Select ASIO as driver model on the upper right corner. Now 
you can assign the different output channels to the different players and functions of BPM 
Studio. 

You can get the latest information about BPM Studio online at http://www.bpmstudio.com. 
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Setting up Nemesys GigaSampler 1.6 

GigaSampler from Nemesys is a powerful and very popular software sampler. The SoundTrack 
Audio DSP24 provides a special GSIF-driver (GigaSampler-InterFace) that allows you to use the 
separate outputs of the card with GigaSampler. 

• Launch GigaSampler and select Config>Outputs. 

  

• Under Wave Out Driver, select Audio DSP24 MultiChannel Driver. 

• Select the Output channels you want to use on the right side under Outputs Enabled. 

• Now assign the Midi Channels mapped to Outputs in the lower area. 

You can get the latest informations and updates of GigaSampler on their website 
http://www.nemesysmusic.com. 


